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This program adds depth to the MS Windows Program Manager groups.  Using it gives
the capability equivalent to being able to create subgroups.  

Features include:
 - no limit on nesting folders (groups) within folders
 - move or copy items from folder to folder using drag/drop
 - run command with browse button which also stores last twelve commands
 - associate command that allows multiple programs to be associated with a single 
extension
 - launch your applications directly from a folder
 - customizable command lines for any item
 - save location, size of folder as well as item positions
 - use virtually any icon on the system to represent items
 - tie two or more folders to the same subfolder
 - display items as icons or just names in a listbox mode
 - password protection
 - multi-select capability in adding, deleting, moving or copying folder items

Folders supports up to two-hundred folders each containing up to two-hundred items.
Note that only up to forty items may be displayed in a folder as icons.  Over forty, the
folder will allow only listbox display mode.

Registration
Note that this is a shareware program.  As such, you may use it on a trial basis for 
thirty days.  After this time, the program should be registered if it is continued to be 
used.  Two payment options are available.  For $35 you receive the latest version and
a printed manual.  For $30 you receive only the latest version of the program.  Please
add $2 for shipping and handling.  The fee is payable to:

      Sloop Software
      6457 Mesedge Lane
      Colorado Springs, CO 80919
      (719) 260-0433

Be sure and specify your name, address, name of the program and where you 
obtained the program when registering.  Also, specify 3.5" or 5.25" disk.  Colorado 
residents, please add 6% sales tax.  Sorry, no credit cards.

Direct any  comments to the above address or email to CompuServe 72540,144 or 
Internet 72540.144@compuserve.com.  Customer support is available to registered 
users and to unregistered users during their trial period.

For information on availability and pricing of a Japanese version contact:

      Personal Data Factory
      Shinjuku yubinkyoku dome
      160 Tokyo Japan

This program is produced by a member of the Association of Shareware Professionals 
(ASP).  ASP wants to make sure that the shareware principle works for you.  If you are



unable to resolve a shareware-related problem with an ASP member by contacting 
the member directly, ASP may be able to help.  The ASP Ombudsman can help you 
resolve a dispute or problem with an 
ASP member, but does not provide technical support for members' products.  Please 
write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442 or send a 
CompuServe message via CompuServe Mail to ASP Ombudsman, 70007,3536.

Folder Commands:

The following sections give detailed explanations on the commands available to a 
folder.  It is suggested that you read the README.TXT file first and then install the 
program.  Take a look at a folder and play around before reading thru this document. 
Most of the functions should be self-explanatory.  Some commands will work with 
multiple items selected.  In order to select multiple items, hold down the CTRL key 
while clicking on each item with the mouse.  To de-select an item, click on it again 
while holding down the CTRL key.

File Menu

New - This command create a new folder.  This can be either a subfolder or a group 
level folder.  Group level folders appear as icons in the group specified during the 
creation process.  Subfolders appear as icons in the folder currently opened.  Note 
that you can create subfolders in subfolders with essentially no limit on nesting 
folders within folders.  Be sure and give each folder an unique name.  Changing the 
case of a letter will not make a name unique.

Open - This command allows you to open or activate, if already open, any folder on 
the system, regardless of it being a subfolder or not.  This allows you to open a 
specific folder without having to hunt it up.  The file currently open is not closed, thus
allowing you to switch between it and any other folder you open.

Save - This command saves any changes made to the folder.  Note that some 
commands will automatically perform a save when executed.  They include delete 
subfolder, rename a subfolder, create a subfolder.

Save Config - The current configuration of a folder may be saved using this 
command.  The configuration includes the size of the folder, the position of the folder
and the location of the items in the folder.  Exactly which of these quantities are 
saved can be set using the Preferences command under the Special menu.  Note that
this function also performs a standard Save when executed.

Name - Using this command, a group level folder may be renamed.  It is grayed out 
in subfolders.  Subfolders must be renamed by their parent folder using the Special 
menu command, Item Name.  Note that the folder icon in the Program Manager 
group must also be renamed using the PM's Properties command.

Delete - This command will delete the group level folder currently open.  That is the 
folder from which this command is executed will be deleted.  Like name it only works 
for group level folders.  Subfolders are deleted using the Edit menu command, Delete
Subfolder from the parent folder.  Two important points to note with this command 
are, first, no subfolders are deleted.  To prevent having any unwanted subfolders left, 
they must be deleted before this command is executed starting from the lowest level.
Second, the folder icon in the Program Manager group must be deleted using the 
PM's delete command.

Run - Allows a command line to be entered and executed.  The last twelve 
commands are stored for easy access.



Exit - Causes the current folder to be closed.  If has not been saved, and changes 
have been made, you will be prompted on whether or not you want the folder saved.



Edit Menu

Add Item - Adds items to the current folder.  A dialog box is presented from which 
you may choose any file on the system.  After choosing, a descriptive name for the 
item must be entered.  This is the name that will show up under the item's icon.  An 
icon will appear which represents the item just added.  By double-clicking on this 
icon, the item may be executed.  More than one item may be added at a time.  
Simply click on each file to be added.  To de-select a file, click on it again.

Delete - 
Item - This command removes the selected item from the folder. It does not 
delete the file associated with the item.  It simply removes it from the folder.  If 
multiple items have been selected, a prompt to delete or not appears for each 
item selected. 

File and Item - This command removes the item from the folder and deletes the 
file associated with the item.  As such, use it only when you wish to remove the 
file completely from the disk. If you wish to only remove the item from the folder, 
use the Delete Item command.  This command does not function with subfolders.  
If multiple items have been selected, a prompt will appear as to whether or not to 
delete it for each item selected. 

Subfolder - Use this command to delete a subfolder.  Note that this command 
completely removes the subfolder.  As such, if you have copied it to another folder
and wish to be able to still access it from this other folder, use the Delete Item 
command to remove it from the current folder rather than this command.  Also, 
any subfolders in this subfolder are NOT deleted.  So be sure and delete these 
other subfolders, first. 

Move - This command moves the currently selected item to the folder specified.  In 
doing so, it is removed from the current folder.  Note that if the folder you are moving
the item to is open, it must be closed and reopened before the new item will appear.  
This commands will work on any item including subfolders.  If multiple items are 
selected, all items selected are moved.   Items may also be moved by selecting them 
and dragging them to the desired folder.

Copy - Works the same as move, but does not remove the item from the current 
folder.  If multiple items are selected, all items selected are copied.  Use this 
command to link two or more folders to the same subfolder.  Simply create the 
desired subfolder using the File menu New command.  Then copy the new folder item
to whatever other folders you wish to be able to access it.   Items may also be moved
by selecting them and dragging them to the desired folder.  Note that the right 
mouse button must be held down when the left button is released otherwise the 
items will be moved rather than copied.

Command Line - Allows you to customize a command line for an item.  Note that 
this command line takes precedence over the file name.  That is, if you have an item 
whose file is LETTER.TXT and TXT files are associated with Notepad, normally 
executing this item would cause Notepad to be ran using the file as the data file.  
However, if you specify the command line as WRITE.EXE LETTER.TXT, the program 
Write will be ran rather than notepad.  By setting the command line to blank, the 
original functionality of the item will be returned.  Note that any type of command 
may be specified on the command line.

Filename - Allows the file name of an item to be viewed or edited.



Special Menu 

Item Name - This command allows you to rename items and subfolders.  When 
renaming subfolders, an automatic save will be performed, otherwise a save must be 
done to keep the new name. 

Item Icon - Allows you to specify which icon is to be used to represent an item.  
Icons may be used located in ICO files, EXE files or ICL files (icon libraries).

Set Default Icon - This command allows you to set or change the icon associated 
with a specific file extension.   Once an icon has been associated with a file 
extension, when an item with that file extension is added, it will automatically appear
with the set icon.
 
Arrange Icons - Arranges the icons in an orderly manner. 

Preferences - This command allow the folder to be customized.  What aspects of a 
folder that are saved when using the Save Config command may be set from this 
command.  Also, the folder can be set to minimize or close on execution of an item in
the folder.  Auto arrange of icons can be turned on or off from this command.  Note 
that if auto arrange is on, the icons will be re-arranged everytime the folder is resized
or minimized.  A password may be assigned to the folder and the display mode may 
be set to icons or listbox mode.  Finally, the icon to be used to represent folder may 
be set.  Once a new icon is assigned to be the folder icon, all subfolders and 
minimized folders will appear using this icon.  However, any folder icons in Program 
Manager groups will still need to be set by hand.  All folders should be closed after 
setting the folder icon to allow the change to take effect.

Using Folders as the Windows shell
Folders may no longer be used as the Windows shell.  Instead, the program Sloop 
Manager is available for that task.  It has similar capabilities to Folders, but is 
specifically designed to act as the shell.

Notes on using icons
Folders is capable of extracting and using icons from ICO's (icon description files), 
EXE's (executable programs) and ICL' (icon libraries created by a third party 
program).  An icon library, FOLDERS.ICL is provided with the program for your use.  It 
must be located in the folders data directory specified upon installation for it to be 
used.  Note that you may delete, copy over or edit (with the appropriate program) 
this file without impacting Folders operation.

There may be some cases where you wish to use an icon in an executable that is not 
the first icon in the executable.  Folders cannot extract these icons itself.  There also 
may be cases where, for some reason, Folders just cannot find the icon in the 
executable (eg. WINWORD).  In order to use such an icon, you will need to convert it 
into an ICO file using some utility such as Icon Manager.  Once this is done, it may be 
added using the Add Icon command.

Some 256 color displays may also not display the icons properly when in 256 color 
mode.  If this occurs, try this fix.  Open the folders.ini file using an editor like 
Notepad.  Under the section [Defaults] will be line which reads 'Color mode=0'.  
Change the 0 to 256.  This tells Folders that you are using a 256 color display.  Note 
that the program will not function in 16 color mode with this setting made.  To 
operate in 16 color mode, change the 256 to 0 or 16.



Hierarchy of icons
There is a hierarchy involved in Folders deciding which icon should be used to 
represent an item.  At the top-level, if an item has had an icon explicitly set for it 
using the Item Icon command, this icon will always be used regardless of any other 
settings made.  Next, if the item does not have an icon set for it, but does have an 
icon associated with its extension, this icon will be used.  Finally, if neither of the 
above is true, if the item is an executable or is associated with an executable, the 
icon for that executable will be used.  If none of the above holds, the item will appear 
using the default icon, which is the DOS icon.

Folders File Structure
Folders creates and maintains a data file for each folder created.  These files end in a 
FL0 extension.  It is suggested you allow the install procedure create a separate 
directory for these data files, simply to avoid cluttering up the Windows directory any 
more than it probably is already.  This is not necessary, though, as the files can be 
maintained anywhere as long as the directory is correctly specified during the install 
process.

An association is created between FL0 files and the folders executive.  When you click
on a folder icon, the exec is ran with the appropriate data file.  The exec itself cannot 
be ran without a data file being specified.

Folders Getting Confused
Should the FOLDERS.INI file get messed up, as will happen if you delete a folder 
without first deleting its subfolders , it can be repaired.  Open FOLDERS.INI with a text
editor like Notepad.  Under the section [Folders List] the name of every folder with its 
corresponding DOS filename is listed.  Make note of the DOS filenames of the folders 
that should be deleted.  Delete those lines.  Close the INI file and go to your folders 
directory.  Delete those files whose names you made note of in the INI file.  If you 
want to save these subfolders, instead of deleting anything, add the file whose name 
you found to a folder naming it with the subfolder name.  A folder icon should be 
created representing that subfolder.



Manual Installation Process

Should the automatic install process fail for some reason, the following process may 
be followed to install the program.

1. Copy FOLDERS.EXE, FOLDERS.INI, FOLDERS.HLP to the windows directory.

2. Create a subdirectory of your windows directory called FOLDERS.   Note this step 
may skipped.  Any existing directory may be used  instead.

3. Copy the file FLD0000.FL0 to your folders directory.

4. Edit the file FOLDERS.INI in the following manner.  Under [Folders Directory] add 
the line: path = <directory>\  where  <directory> is whatever directory you want the
folder data files placed in.  Note the backslash at the end of the name.  An example 
line would be: 
          path = c:\windows\folders\

5. Under the [Folder List] section add the line: 
      Empty Folder = fld0000.fl0
  That is all you need do to FOLDER.INI.

6. Next, create an icon for FLD0000.FL0 in a group in any of the manners described 
by the Windows documentation.  Name it Empty Folder. 

7. Finally, from the File Manager, using the associate command under the File menu, 
associate FOLDERS.EXE with .FL0 files.

8. That's it.  You should now be able to open and use your first folder.

Folders License Agreement

License Agreement
No part of this manual may be reproduced, transmitted, transcribed, stored in a 
retrieval system, or translated into any language (natural or binary), in any form or 
by any means, except as described in the following license agreement or without the 
express prior written consent of Sloop Software.
                          
The use of Folders is subject to the following terms and conditions.

Title To The Licensed Software
Title to the licensed software is NOT transferred to the end user. The end user is 
granted an exclusive license to use the software on a SINGLE computer or computer 
work station. EACH computer or computer work station must have its own licensed 
copy of the software.

Copyright Protection
Folders is copyrighted material. It is protected by the copyright laws of the United 
States, the State of Colorado, and other proprietary rights of Sloop Software. You may
not make any changes or modifications to Folders or this manual. You may not 
decompile, disassemble, or otherwise reverse-engineer the software in any way.

You may make copies of Folders only under the terms of the section entitled "Limited 
License To Copy The Licensed Software".



You may use Folders on a trial basis provided you do not violate the protection 
afforded the licensed software by the copyright laws, and you agree to the terms of 
the license agreement. If you use Folders on a regular basis you are obligated to 
purchase it.

Limited Warranty
Sloop Software does not warrant that the licensed software will meet your 
requirements or that the operation of the software will be uninterrupted or error free. 
The warranty does not cover any media or documentation which has been subjected 
to damage or abuse by you.

The software warranty does not cover any copy of the licensed software which has 
been altered or changed in any way.

ANY IMPLIED WARRANTIES INCLUDING ANY WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED TO THE TERM OF THE EXPRESS 
WARRANTIES. Some states do not allow limitations on how long an implied warranty 
lasts, so the above limitation may not apply to you.

Other Warranties
The warranties set forth above are in lieu of any and all other express or implied 
warranties, whether oral, written, or implied, and the remedies set forth above are 
the sole and exclusive remedies.

Limitation Of Liability
Sloop Software is not responsible for any problems or damage caused by the licensed
software that may result from using the licensed software. This includes, but is not 
limited to, computer hardware, computer software, operating systems, and any 
computer or computing accessories. End user agrees to hold Sloop Software harmless
for any problems arising from the use of the software.

Sloop Software SHALL NOT IN ANY CASE BE LIABLE FOR ANY SPECIAL, INCIDENTAL, 
CONSEQUENTIAL, INDIRECT OR OTHER SIMILAR DAMAGES ARISING FROM ANY 
BREACH OF THESE WARRANTIES EVEN IF Sloop Software OR ITS AGENTS OR 
DISTRIBUTORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  Some 
states do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you.

In no case shall Sloop Software's liability exceed the license fees paid for the right to 
use the licensed software, or a sum no greater than one Dollar ($1.00), whichever is 
less.

Limited License To Copy The Software
You are granted a limited license to copy Folders ONLY FOR THE TRIAL USE OF 
OTHERS subject to the terms of this software license agreement described herein, 
and the conditions described below are met: Folders MUST be copied in an 
unmodified form and FOLDERS.ZIP MUST contain the following files:

    FOLDERS.EXE - the Windows executable program (shareware version only)
    FOLDERS.WRI - the program documentation
    FOLDERS.INI - Folders initialization file
    FOLDERS.HLP - Folders help file
    FOLDERS.ICL - icon library
    FLD0000.FL0 - empty folder for manual installation process
    FINSTALL.EXE - Folders install program
    README.TXT - installation information



    ORDERFRM.TXT - Folders order form
    VENDOR.DOC             - shareware vendor information

-> No fee, charge or other compensation may be accepted or requested by anyone 
without the express written permission of Sloop Software.

Public Domain Disk Vendors May NOT CHARGE a fee for Folders itself. However you 
may include Folders on a diskette for which you charge a nominal distribution fee. 
The purchaser of said diskette must be informed in advance that the fee paid to 
acquire the diskette does NOT relieve said purchaser from paying the registration fee 
for Folders if said purchaser uses Folders.

-> Operators of electronic bulletin board systems (Sysops) may post Folders for 
downloading by their users without written permission ONLY AS LONG AS THE ABOVE 
CONDITIONS ARE MET.  A fee may be charged for access to the BBS AS LONG AS NO 
SPECIFIC FEE IS CHARGED FOR DOWNLOADING Folders files without first obtaining 
express written permission from Sloop Software to charge such a fee.

The above constitutes the license agreement for Folders. It supersedes any and all 
previous license agreements.


